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RSEEE K LED

AT AL H PICZ4FJ128GA010T§TE?1‘%J§% (Plug-In Module, PIM) %2 % 15 %% Explorer
16/32F KR LIMLED. 258, iEZSWHEBT “ IR FHELE” .

#include <xc.h> --&— {HFH )uﬂ%1 179

// PIC24FJ128GA010 Configuration Bit Settings

// For more on Configuration Bits, -&—— {FZWLFE1.20
// consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // OSC2/CLKO/RC15 as port I/O (RC15)
#pragma config FCKSM = CSDCMD // Clock Switching and Monitor disabled

#pragma config FNOSC = PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled
// CONFIGI1

#pragma config WDTPS PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

#define LEDS_ON OFF 0x55 -#—— iHEZNH1.37
int main (void) {

// Port A access &—— iFZSWE147

AD1PCFG = OxFFFF; // set to digital I/O (not analog)
TRISA = 0x0000; // set all port bits to be output
LATA = LEDS ON OFF; // write to port latch

return O;

1.1 L <xc.h>
R S SO SO IR SO A AR RS U 1) G 13 2% B 2SR e O Zh BE . AT AE MPLAB XC16 %223
H 3% support F H 3 N3 BIA Sk SO R H A Sk S04

G 1 A AR O PRI AR M BC AR 0, DM < n Fi5 1A IR I 85 R4 5 Sk S0 38
PR SR € RSO RS AR A CRS R, 75 R S BURS AN AT R 4
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1.2 FEEAL
Microchip 23 F B A L B 2 /7 2%, FLApI0az nl B T8N/ sk ik & 23 Th ek
VE: WRRIEHBEREN, KT EEIT, BEDAEIIZEIT, I

1.2.1 B E WA E AL

TEREAE R LR LI

« RGIEFE—— LIS BT IR S UL . SRR E AR, A0 TR
EAE T, WEAFOLT, TR E s iR o s A AR A
#pragma config FNOSC = PRI

#pragma config POSCMOD = XT

o Bl 8—EWAE L EN A B2 E N 28 . IXFER BT b B L. R A
KA

#pragma config FWDTEN = OFF

o ARERARY——E W BEIN SC HARRD LRI . IXRE VT IR 25 1 7 i s 1) S 2 vy 1] 75 o
Y EPSAMEY IR

fpragma config GCP = OFF

A 16 2231 (M AEA R BRI MCUD B, FTRET SR B AR AR E L.
2 LB R AR B M T M RS B AL I 4% RR R Th BE. Wl {3 A e S 7
http://www.microchip.com % 21 8 (6 58k -t

AR R E A 2452, 152 MMPLAB XC16 2235 4% F iU R S04

MPLAB XC16 Installation Directory/docs/config index.html
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1.2.2 BCE BCE AL 7%

7EMPLAB X IDE ', W] 1# ] Configuration Bits (it Bfr) & & H M Bix Ly, i
% £ Window>PIC Memory Views>Configuration Bits (% I'1>PICTZ %2540 &>l B 1)
FFZE

& 1. REEMEO

Qutput |Configuration Bits = | =1
@ Address | Hame Value | Field Option Category Setting
.5' CONFIG2 FFFF POSCMOD _NON'E‘. v_I—‘x:'ima):‘f,r Oscillator Select _Frimary o3scillator disabled
%IJ OSCIOFNC OFF Primary Oscillator Output Function 0SC2/CLEO/RC1S functions as CLKQ (FO0SC/2)
(r—————————— FCKSM CSDCMD Clock Switching and Monitor Clock switching and Fail-Safe Clock Monitor arg
6 FNOQSC FRCDIV Oscillator Select Fast RC Oscillator with Postscaler (FRCDIV)
- — IESO oN Internal External Switch Over Mode IESO mode ({Iwo-Speed Start-up) enabled

w“f'tsﬁ.”"e Code in Bditor e ——irres P532768 Watchdog Timer Eoatacaler 1:32,768

FWESL FR12E WDT Prescaler Prescaler ratio of 1:128

WINDIS oN Watchdog Timer Window Standard Watchdog Timer enabled, (Windowed-mode

FWDTEN oN Watchdog Timer Enable Watchdog Timer is enabled

Ics PGx2 Comm Channel Select Emulator/debugger uses EMUC2/EMUD2

GWRE OFF General Code Segment Write Protect Writes to program memory are allowed

GCP OFF General Code Segment Code Protect Code protection is disabled

JIRGEN oN JIRG Port Enable JIAG port i3 enabled

T

n [3

Memary :Ccnﬁguraﬁon Bits

g Format _Read,.'erte = ‘ Generate Source Code to Output |’

RN EE, PR EEERE pragma INE MM E A IARDS, Jf 5.5 Insert Source
Code in Editor (7fE4mE a8 P NJRACAD) BbR.
5%, A Generate Source Code to Output (/R TR , AR5
¥ pragma Dh T4 N H & 1R i B FARRS .

1.3 NLEDMHE X%
w1 priA, 5 NLED F{E AR E % fiid 4% (LEDS oN OFF) , HJLED D3.

D5. D7 /ID9#4 #i5%, LED D4, D6. D8MID10K KK . £ Jiim bR 5 21 B B 15
B, S BAT “IRAUA R .
1.4 SOV
SR 1O 5T 5 4h B 1/0 51 BN E o i R 2 i AU A B 110, /5 45 1k K Ad Ak
W NIk, W AARRINMEE A A L ALK C AR . XA B A T4 4% include H
KN ISR E SR . R T IREE AN TR LE SRR AE B, 1§ S W EAR SR
PaEF M
XTATRERIRB], i D AGES RN EE ISR T o HE— 1 IR RAE T 1 28 5] RRVER A
BCE L0, FIMFH LR N ENE 710!

ADIPCFG = OxXFFFF; // set to digital I/O (not analog)
BAE T E B R A B VO 3 11 (PORT) BREA7 8% (LAT) ZFA7av. /Bl 46 H
LATA. %:LEDS ON OFF A1 a%:

LATA = LEDS_ON _OFF; // write to port latch
BEAh, A AN ARG T E R TT R NI R, ERRN TRIS i fedt. A
TR TRISD I TRISB. AL BEE N 0 ALk SISOt , K Ar B B 9 1 Al
SR o ST AR

TRISA = 0x0000; // set all port bits to be output
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2. ffif_delay () B%ff LED NAR
ATRBIAE b — 7= AR B BE il b AT 8 e AR A SR LED, 8K LED A&
AR o
#include <xc.h>
#include <libpic30.h> -@—— HFSNE2.170

// PIC24FJ128GA010 Configuration Bit Settings
// For more on Configuration Bits, consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // 0OSC2/CLKO/RC15 as port I/O (RCL5)
#pragma config FCKSM = CSDCMD // Clock Switching and Monitor disabled

#pragma config FNOSC = PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled
// CONFIGI1

#pragma config WDTPS = PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

#define LEDS ON OFF 0x55
#define LEDS OFF ON OxAA
#define IC DELAY 1500000

int main (void) {

// Port A access
AD1PCFG = OxFFFF; // set to digital I/0O (not analog)

TRISA = 0x0000; // set all port bits to be output
while (1) ( -&—— iHSILH2.24

LATA = LEDS_ON_OFF; // write to port latch

// delay value change -#—— {E&N52.37
~_delay32(IC_DELAY) ; // delay in instruction cycles
LATA = LEDS_OFF ON; // write to port latch
__delay32(IC_DELAY); // delay in instruction cycles

}

return -1;
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21 Rt

TE A ) b, Aff H libpic30 4 1% #5 FE HH Hdelay32 pR 4. U5 18] %, b O EF
libpic30.ho

2.2 while() EAMZEMA

LAL S A ERILED KL, FRAEMEH 105 —# 7y NPORTAIR{E %% LEDS_ON_OFF,
SRIGAENRIR 28 35> N PORTAIR{H H %A% LEDS_OFF ON. il T while (1) { }
PATTEHA .

IR ERHOR ], WA AAAERT R, By while TR W AN LA B, R (A
-1,

23 delay() B¥
T AT 3 B AR K 2 0 U0 72 S BULED f IR R385 88 N IR AR A B g, DR
BRCHATIEE . _ delay32 () R4 3 AT LA AT P2 R 5K

ARIER BB EZFHGEL, HS U S%F M (6AEF T A K E)
(DS51456D_CN) .
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3. fH R WA A ZER £E LED a5k
FRIE _E— R BTG B R RE AT 0. JRAE b — R 18] o () ZE IR B8 B0t T [ A 0
AT IR Y, (R S e R op B NSy i 1], A3 G g — 1), T o ) o2 B 2
H T

#include <xc.h>

// PIC24FJ128GA010 Configuration Bit Settings
// For more on Configuration Bits, consult your device data sheet

// CONFIG2

#pragma config POSCMOD = XT // XT Oscillator mode selected

#pragma config OSCIOFNC = ON // 0SC2/CLKO/RC15 as port I/O (RC15)
#pragma config FCKSM = CSDCMD // Clock Switching and Monitor disabled

#pragma config FNOSC = PRI // Primary Oscillator (XT, HS, EC)
#pragma config IESO = ON // Int Ext Switch Over Mode enabled
// CONFIG1

#pragma config WDTPS PS32768 // Watchdog Timer Postscaler (1:32,768)
#pragma config FWPSA = PR128 // WDT Prescaler (1:128)

#pragma config WINDIS = ON // Watchdog Timer Window Mode disabled
#pragma config FWDTEN = OFF // Watchdog Timer disabled

#pragma config ICS = PGx2 // Emulator/debugger uses EMUC2/EMUD2
#pragma config GWRP = OFF // Writes to program memory allowed
#pragma config GCP = OFF // Code protection is disabled

#pragma config JTAGEN = OFF // JTAG port is disabled

// Interrupt function -w—— EZSWNFEIAT

void  attribute ((interrupt, no auto psv)) TlInterrupt (void) {
// static variable for permanent storage duration
static unsigned char portvalue = 0;

// write to port latch

LATA = portValue++;

// clear this interrupt condition
_T1IF = 0;

int main (void) {
// Port A access
AD1PCFG = OxFFFF; // set to digital I/0 (not analog)
TRISA = 0x0000; // set all port bits to be output
// Timerl setup -&—— FSIFE3.27
TICON = 0x8010; // timer 1 on, prescaler 1:8, internal clock
_T1IE = 1; // enable interrupts for timer 1
_T1IP = 0x001; // set interrupt priority (lowest)

while (1) ;

return -1;
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31 iR Hise ()

A H interrupt J& 11 5 2R Hh BT ok B M4k, I8 R FE E R T A )R]
(Program Space Visibility, PSV) . ARl b f g, NMEATEMAPSV. KPSV
FLEHE, 530 (MPLAB® XC16 C4ii# s 487 ) (DS50002071E_CN) .

AR E T Timer1 K EH WM& TlInterrupt. ka2 H RN docs AR T2
HE T AR R R

TERW R EF, s portvalue 2 1E Timer1 FoAE HR BB
3.2 Timer1i&E

T AC R AE B E P W AR ST RE e AT, DRI IE 7 1) AR R AN N A S ACRY LA RE
ANBLE E I &5+ FOVFRE 45 Fh 7 DA K S e Bt A 4 T A
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4. f#F ADC7ELED | &R 7 88H
AT/ 5 bR A4 B A R 284 DA B3 1A LED . EAEASRB A, s FH S s il
HALAs CEEYD MER S I O B AR 428 (Analog-to-Digital Converter, ADC)
N, RNEFATHAIF BoRAELED .
RIBTLEFFERE, Wil HMPLABRLAL E# (MPLAB Code Configurator, MCC)
4 . MCC 2 — & #fi £, 7 7 MPLAB X IDE 3¢ # Tools>Plugins ( T. B> &) )
Available Plugins (W] H#diff) &I~ T3, ARUMMALZEEFNEZEE, S
. MPLAB X IDE #; 81,

5 KMCCHI 245 B UL K (MPLAB®AEIN & 4% /i 1 5 7)  (DS40001725B_CN)
1857 ) BAR URL HH ) MPLAB RS FiE B 25 X 7T :
http://www.microchip.com/mplab/mplab-code-configurator

ARG P T MCC I B AN AR % B .
RGER

& 2: ADC T H %8

Projects | Files |Cl.asses | Resource Management [MCC] 2 [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module

System Module
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K 3: ADCTiH RGHERELE

StartPage 3|4 MPLAB X Store |LE) MPLAB® Code Configurator % ETE3=)

System Module 0  ©

i

-

{E:}' Easy Setup E Registers | /8 Motifications : 0

¥ INTERMAL OSCILLATOR

2000000 * | Hz | FRC Oscillator * | (8.0 MHz) Clock Source

» | | FRC Postscaler

8 MHz Fosc

4 MHz Fosc/2

Clock Qutput Pin Configuration | O5C2/CLKO/RCLS functions as CLKO {FOSC/2) v

I:‘ Use Secondary Oscillator (31 -33) kHz

I:‘ Enable Clock Switching
I:‘ Enable Fail-5afe Monitor

¥ ICD

Emulator Pin Placement | Emulator/debugger uses EMUCZ/EMUD2 v

¥ WATCHDOG

Enable | Watchdog Timer is disabled b

Clock Settings ‘

Mode Standard Watchdog Timer enabled, (Windowed-mode is disabled) - ‘

Timner Prescaler Prescaler ratio of 1:128 > ‘

Timer Postscaler | 1:32768 -

Time-out Period 131.072=
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K 4. ADC 7l H %y —— ADC ik

Device Resources

¥ Documents
PICZ4FJ128GA010 Product Page
¥ Peripherals
v Bo ADC
%ADCI Double click here to move to
P —CVR

» il Comparator

b iP5 Fvt Internint

Projects | Files | Classes | Resource Mayﬁement [MCC] = [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module
System Module

¥ Peripherals

&y apC1
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A 5. ADCTjiH ADC1ECE

StartPage |4 MPLABX Store LB MPLAB® Code Configurator 5 L= (=]
ADC1 > YINE)
{g} Easy Setup E Registers ,L Metifications : 0
¥ Hardware Settings
Enable ADC
Enable Auto Sampling
ADC Clock
Differential Sampling | AVSS | >
Conversion Clock Source | FOSC/2 | -
Conversion Trigger Internal counter ends sampling and starts conversion | >
Conversion Clock 1 TCY
Cutput Fermat | Absolute decimal result, unsigned, right-justified | >
Acquisition Time TAD
Positive Voltage Ref | AVDD
TALD:
Megative Voltage Ref | AVSS
|:| Enable ADC Interrupt
Selected Channels
| Channel Custom Mame
ﬁNS channel_ANS

RB5 = ANS LK £E 1 6 A Bk B 52 il 5 SBom

& 6: ADC i § ADC1 5| %5

Qutput | Pin Manager: Grid [MCC] 2 |
Package:|TQFPlCO|'| | Pin No: 17|33|53|59|ﬁu|51|91|9z|2s|29|56|57 25|24|23|22|21|20|26|27|32|
PortA Y PortB ¥
Module Function Direction |0 | 1|2 |3 |4 |5|6|7|9(10(14(15| 0|1 (2|3 |4|5|6|7|8
ANx input - O R
ADCLW VREF+ input B
VREF- input B

DS50002446B_CN 551271
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Kl 7:

ADC T H I8 —— 51 KSR

Projects | Files | Classes

Resource Management [MCC] &

=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module
Lystem Module

¥ Peripherals

Bo aDC1

&8:

ADC i H /O 5| Hific B

StartPage 5| MPLAB X Store 5050 MPLAB® Code Configurator 5 EREE
Pin Module (7 =
£0% Easy Setup | (5 Registers | /8 Notifications: 0
Selected Package : TQFPL00
Pin Name 4 | Module Function |Custom Name| Start High Analog Output WPU WPD oD 10C
RAO Pin Module  |GPIO 10_RAD ] ]
RAL Pin Module  |GPIO 10_RAL ] ]
RAZ Pin Module  |GPIO 10_RAZ ] ]
RA3 Pin Module  |GPIO 10_RA3 ] ]
RA4 Pin Module  |GPIO 10_RA ] ]
RAS Pin Module  |GPIO 10_RAS ] ]
RAE Pin Module  |GPIO 10_RAG ] ]
RAT Pin Module  |GPIO 10_RAT ] ]
RBS ADCL ANS channel_AN O O | | .
RE6 ICD PGC2 ] ] ] ]
RE7 1cD PGD2 ] ] ] ]

EE9HIEHF 5 IRAC7 /5, 1XEe5| JiLk B/ FIH 1 E .
16 1z HiriE ) /& RB5.

RB6 #1 RB7 il S e £ A TR il (5

EE O ERE, ORGSR BSOS N E

© 2018 Microchip Technology Inc.
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& 9. ADC i B 1/0 5| 3% JE

Output | Pin Manager: Grid [MCC] 2 |
Package:|TQFP].\}:J|'| | Pin No: 1.7|33|58|59|GD|61|91|92|23|29|66|67 25|24|23|22|21|20|26|27|3Z|
PortA ¥ PortB ¥
Module Function Direction |0 | 1|2 |3 |4 |5|6|7 |9 |10|14(15(0| 1|2 |3 (4|5|6|7|38
ANx input O G RGN AR BN
ADC1Y VREF+ input B
VREF- input B
PGCx input B a8
o PGDX input B a8
0sC CLKO output
ey | s Bl B BlElEs s B e e s e e R e
GPIO output 6 A A A A A Aa I R I I I R

DS50002446B_CN %5 14 71
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& 10: ADC T H 5| i3

Pin Manager: Package [MCC] 2

reg| J19

22
Sk <
a5k e -
RfBC CBRR2E353232238332238383
.IJ_l_II_JLIl_JLII_JI_IuLII_JLIULI“ULIULIULIULIU J
100 99 98 9/ 96 95 94 U3 92 U1 90 89 B8 B/ B6 85 B4 83 B2 81 B0 /9 /8 /) /b
RG1s[ ]2 /s [lvss
voo [l 2 74[|rcia
RES| 3 i3[Creaz
REG| |4 72[|roo
Re/[ s ® n[Jro1
rei s 70[Jro1n
rez )7 69 [|RDY
rez| |8 aa[_|rpa
rea[ o S [ING
RGa[ ]10 66 [ |rais
re/[Ju 65 [ vss
- MICROCHIP -
rcLr il 23 63 |rc1z
Rea| 14 &2 [lvoo
vss [l 15 61 [|Ras|i0_RAs|GPIO
voD [Bl16 60 [|Ra4lio RA4IGFIO
RAOIO_Rao|GPIO[ 1/ PIC 24 FJ 1 2 8 GAO 1 0 s9 [|Ras|io_ras|Grio
Rea| J1s sa[C|raziio Ra2iGRio

s/ [Jraz

RBS|channel ANS|ANS|]20 sa[_|rGz2
re4[ o ss [Jrre
RBa| |2z sa[|rF7
(7] W PE s3[|rra
RE1[ |24 s2[C|re2
RBo| J2s s1[]re2

Zb 24 28 2% 30 31 32 33 34 35 36 3/ 38 39 40 41 42 43 44 45 46 47 48 4% L0
Hinininivivininininisivinininininininisisinininin
2EEELEEEEEZSEEREEREZSSEER
S YPESR*TETEEYOELRERERELRYORYG -
Ing o} o
N R 2

=

A}

-

g
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PR R % T B e RS S, 15 R “Project Resources”  (IiH % iE) & 1 LK
Generate (R0 %41 (E7) . i@iEMCC ARSI 2L . Bk, FRFAR
i RGACE NSNS IO T B SO . Ak, BEANMEEE B RSk S

A3 A R S SR A VB A AR R . R AR N FE RN S A I, (H SR
T AR SO SR A A
AR PR NI eI 1A 24 T B main . c. 5 A A AL BRSO DAFR 2144 (AR AT o i) A

5 L IR R B
11 iEiT MCC 4 sk A% ) ADC T H #%

Projects # | Files |Classes | Resource Manag... [=]
E‘m

E}[aﬂ Header Files

EI[E_ﬂ MCC Generated Files
>E| adcl.h
E] interrupt_manager.h
>E| mei.h
>E| pin_manager.h
EI traps.h

E—}-E Important Files

b '-E‘] Makefile
[ MyConfig.mc3
[ai Linker Files

E}'E Source Files

EIE MCC Generated Files
E] adcl.c
>E| interrupt_manager.c
L mec.c
>E| pin_manager.c
L taps.c
E Libraries

g Loadables

DS50002446B_CN %516 7T
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41 main.cBX)EMRG
main.c BRSO A dmtE, WFR. SHoFEEH< >3, RO, #ridm
Flmain () PRI LA AR R,
/‘k*
Generated Main Source File

<See generated main.c file for file information.>

*/

/*
(c) 2016 Microchip Technology Inc. and its subsidiaries. You may use
this software and any derivatives exclusively with Microchip products.

<See generated main.c file for additional copyright information.>

*/
#include "mcc generated files/mcc.h"
unsigned int value = 0;

/*
Main application
*/
int main (void) {
// initialize the device
SYSTEM_Initialize();

while (1) {

// Wait for conversion -w—— FHESNEHE4.27T
// and then get result

while (!ADC1 IsConversionComplete());

value = ADCl ConversionResultGet ();

// Shift for MSb
value = value >> 2;

// Write to Port Latch/LEDs -#—— {520 5%4.37
LATA = value;

}

return -1;
}
/**
End of File
*/

© 2018 Microchip Technology Inc. DS50002446B_CN 517 7T
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42 ADCH¥ KR

MCC & id 1% & AD1CON1 F 78 H I SNk sE ADC . 8 H H 2 R RE UL L FEH A
T BB A SRR IR S i ¥, I, main () ACRD R FE B fe it I 4k R IR RN 45 IR,
i adcl . c PRI BB 4L

bool ADC1l IsConversionComplete (void)
uintl6 t ADCl ConversionResultGet (void)

AR EHAMADCIIBENIE R, S0 (PIC24F RFIZ% Ft) M7 5 “10 it
it (ADC) 7 (DS39705A_CN)

BT RAA8ALEDH M, 1 ADCHHR R 104z, FIAZ & value IR K
AL AR R e 840, 7 BRI

4.3 B OYELSMLED
ADC ¥ ¥ s B value ¥ EonrEu 0 AR LED .
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5. £ LED I E/R EEPROM##E{H
A4 H 55— 2 Microchip 231 PIC24F32KA304 MCU 5 Explorer 16/32 K45 Hic, i
NUA 5 EEPROM##: (EEData) . S2HUAME /R 7E M ="k 5 A (9 LED E.
ff HH MPLAB RIS B 28 (MCC) SRAE AL AT . B8R T fift nfa] 22 % MCC ATFEELMCC
FPfREriER, SR $475 “fiHH ADCAELED FE/RHEALSE” .
AIRBIFEFMCC GUBR B RG (IR sy EFACE AL PL G I A, BFICHIE
F1/0 (General Purpose I/0, GPIO) ([12) . {HsE, MCCH Hui& A H T 16674}
4 i) EEData £ 4F % Ji .
fi ] EEData f £ Bt /% B AR RS 7E 28 14 28 T M A1 (dsPIC33/PIC24 241 2% F i) 1)
F5% “YIMEEPROM” i, —FHINALT LU R AR i
http://www.microchip.com/PIC24F32KA304

K 12: EEDATAJi H %5 REGiHER

Projects | Files |Clﬂasea | Resource Management [MCC] 2 [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module

System Module
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& 13: EEDATATI H 2GR ECE

StartPage %y MPLAB X Store [ MPLAB® Code Configurator 5

System Module

lﬁif;‘ Easy Setup | = Registers

/&, Natifications : 0

¥ INTERMAL OSCILLATOR

| 2000000 * | Hz | FRC Oscillator * | (B.0 MHz) Clock Source
v FRC Postscaler
8 MHz 11 +* | Postscaler

[ ] pLLEnable

Clock Output Pin Configuration

|:| Use Secondary Oscillator

|:| Enable Clock Switching

8 MHz Fasc

4 MHz Fosci2

CLKO cutput disabled

D Enable Fail-5afe Monitor

(31 -33) kHz

¥ ICD

Emulator Pin Placement | EMUC/EMUD share PGC3/PGD3 -

¥ WATCHDOG

Enable | WDT disabled in hardware; SWDTEN bit disabled

Clock Settings

Mode Standard WOT selected{windowed WDT disabled)

Timer Prescaler | WDT prescaler ratio of 1:128 -

Timer Postscaler | 1:32768

Time-out Period  131.072s

-]
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& 14: EEDATA T H % JF —— 5 Ik

Projects | Files |Classes | Resource Management [MCC] & [=]

Project Resources Generate

¥ System
Interrupt Module
Pin Module

System Module

& 15: EEDATAT H /O 5| R &

StertPoge |}y MPLABX Store |5 MPLAB® Code C P EEBE
Pin Module e @
%}3} Easy Setup | 5 Registers | A\ Notifications: 0
Selected Package : TQFP44
Pin Name & Module Function Custom Name Start High Analog Output WPU WPD oD 10C ‘

RAZ Pin Module GPIO LEDD D D none | =
RALD Pin Module GPIO LED2 | | none | =
RALL Pin Module GPIO LED1 D D rone | =

RB2 Pin Module GPIO LEDE | H | O | none | =

RB3 Pin Module GPIO LEDT ] O Ol ] | rone |~

RES fray PGED3 O O O
RB6 €D PGEC3 ] ] | rone | -
RB12 Pin Module GPIO LEDS | O | O ] none | =

RCE Pin Module GPIO LED3 o | none | =

RCY Pin Module GPIO LED4 D D rone | =

EE16 %k 5] HRA9:11. RB2:3. RB12FIRCS8:9/5, iXLes| ik Bl FiifE O,
RB6 1 RB7 #is ke £ H i8S .
EE DR ERGE, AONEA S AR BGE S5 AL E .
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& 16: EEDATAT H /0 5| % B

Output | Pin Manager: Grid (MCC] & |
Package:‘TQFPMl" ‘ Pin No: 19|20|3I)‘31|34‘18|7‘6|32‘35‘11|1! 21|2z‘23|24‘33|41|4;‘43|44‘1|x‘9|w‘11‘14|15 2;|25‘27|35‘37|33|2‘3|4‘5
PortA ¥ PortB ¥ PortC'¥
Module Function Direction |0 |1|2|3|4|5|6 7|8 9 (101101 | 2|3|4|5|6 78|09 10(11(12(13(14(15 0|1 2|3 4|5|[6| 7|89
PGCx input B
bl 4 oo p— w a .
CLKO output B
051 input B
oscY 05CO output B
SOSCI input B
S0SCO output B
orsrosney |5 input R N M T B B T T T B B T T A BT I B R MGG R RCRAC RCOC
&Flo sutput wlblb|Blb|- bbb 6 alawlbalenslsnlsnsnlabssslsslslnlsltalaa
RESET MCLR input a

&17: EEDATAT B 5] i

Pin Manager: Package [MCC] & | [
=
Lo
o & r
s D g
8 & a
22255 5RABRE=E
[ B T S W v B, SR, TR - S i Y
o LILILIL EE OO0
44 43 42 41 40 39 38 3/ 36 35 34
rReg| |1 33[|re4
res| ]2 12[ |ras
il I E! 31[|Ras
RCE|LEDZ|GPIO| |4 [ fraz

RCY|LEDAIGRIO] ]s

“H' MICROCHIP (2%~

Rae| ]/

re10[ s PIC24F32KA304 i

re1i_Ju RCO
RE12|LEDS|GPIO| |10 24 |rRB2|LEDT|GPIO
RE13 23[|rez|LEDe|GPIO

Fut
[

RC2

alats

L

14 15 1o 1/ 18 1% J20 A1 Jd
Himinininimininin
EEZZZEZEE
AW gL T T

olgolzaioTvd i
cldoltaatltove|_|=
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F e Bk % A E 2SS, 15 “Project Resources” # I E ) Generate 1441l .
Wt MCC A R ARG R B A i) . IRk, EFRRFRIS . RGN SRR 4L -

S BEAh, RAMINEAT H SRk

A A BB B SO R P A AR IR . R AN R TR AN S A b, (H 2 AR
Hh T PR SR SR A

’18:

B MCC 4 sk 4R FS i EEDATA T B #%

Projects | Files |Ckasses Resource Manag...

=l

=[G Examples

—[a:_‘| Header Files

—Gﬁ MCC Generated Files
E] interrupt_manager.h
IE-I mee.h

E] pin_manager.h

=g Important Files

b Makefile
[ MyConfig.me3
[a:j Linker Files

—ﬁ Source Files

& Gﬁ MCE Generated Files
|'|5|:‘| interrupt_ranager.c

BB mec.c

rF':‘] pin_manager.c

(g Libraries

E; Loadables

© 2018 Microchip Technology Inc.
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GPIO A B XA BRI, A Z0fE pin manager . c HOR B SO B4
A (BB51F) &

A48, BTFLEDA REEZR— N A, Wi AmE =m0 b, Bk EAE AN
A g SCFMRAE Kok 1E 7 1 LED B B 25 0t 1 51 Bl. Sk F LEDs .h (355.2715) AIC
Y LEDs.c (5.3 S mEITHEH.

WETSCHTId, MCCH Hai& A T 16 8344 /) EEData 34 % IR, LT EF3)
WIS . Sk eedata.h (555.475) MC X ffeedata.c (FE5.5F) SaInE|m
Hr,

BRI I5 H R an & 19 B

’19: EEDATATH B i — B £

Projects 2 | Files |Cl.asses Rezource Manag... [=]
=M= WEvample5

E—}ﬁ Header Files
i eedata.h

3 mech

E-(&g Important Files

b Makefile
L..[E8 MyConfig.mc3

[a:j Linker Files

[—}-ﬁ Source Files

o I eedata.c

BB mec.c

(g Libraries

E; Loadables

) FE PP R R N T RERT 4R 28 75 g4 main. ¢ (B55.6717) o 1A AL AR SCER A b se
P LR B S5 PR AR o T B 75 2 AT AT R B
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51 pin_manager.cBX/EHRINRE
main.c BB CEE W, WA MAEBEMERNNER < >k, #ro
MR . OSSR LAt R .
/**
System Interrupts Generated Driver File

<See generated pin manager.c for file information.>

Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated pin manager.c for additional copyright information.>

*/

/x*
Section: Includes
*/
#include <xc.h>
#include "pin manager.h"

/**
void PIN_MANAGER_Initialize(void)
*/
void PIN MANAGER Initialize (void) {

<See generated pin manager.c for port setup information.>

/********************************************************************

* Setting the Analog/Digital Configuration SFR(s)
********************************************************************/
ANSA = 0x0;
ANSB = 0x0;
ANSC = 0x0;
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5.2 LEDs.h/Vhg
EROERH < >HER, oM.

* PICF32KA304 LEDs header

(c) Copyright 1999-2015 Microchip Technology, All rights reserved

* % o

<See generated header files for additional copyright information.>

*/

/********************************************************************

* Union of structures to hold value for display on LEDs
* LAT LEDx - bit fields of value
* w - entire value
************************‘k**********‘k*******************************/
typedef union {
struct {
unsigned LAT LEDO:
unsigned LAT LEDI:
unsigned LAT LED2:
unsigned LAT LED3:
unsigned LAT LED4:
unsigned LAT LED5:
unsigned LAT LEDG6:
unsigned LAT LED7:
Vi
struct {
unsigned w:16;
bi
} LAT LEDSBITS;
extern volatile LAT LEDSBITS LAT LEDSbits;

Ne Ne Ne Ne o Ne N N

e e e e

~.

/* LAT LEDSBITS */

#define LEDO LAT LEDSbits.LAT LEDO
#define LED1 LAT LEDSbits.LAT LED1
#define LED2 LAT LEDSbits.LAT LED2
#define LED3 LAT LEDSbits.LAT LED3
#define _LED4 LAT LEDSbits.LAT LED4
#define LED5 LAT LEDSbits.LAT LED5
#define LED6 LAT LEDSbits.LAT LED6
#define LED7 LAT LEDSbits.LAT LED7
#define LEDS LAT LEDSbits.w

/********************************************************************

* Function: DisplayValueOnLEDs

* Precondition: None.

* Overview: Display input value on Explorer 16 LEDs

* Input: Value to display

* Output: None.

*******************************************************************/
void DisplayValueOnLEDs (unsigned int value);

/**

End of File

*/
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5.3 LEDs.c/\hg
HWArEBRH < >Hik, Bk,

/**
Display on LEDs Source File

<See LEDs.c for file description information.>

*/

/*
Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated header files for additional copyright information.>

*/

#include "mcc generated files/mcc.h"
#include "LEDs.h"

volatile LAT LEDSBITS LAT LEDSbits;

/********************************************************************

* Function: DisplayValueOnLEDs

* Precondition: None.

* Overview: Display input value on Explorer 16 LEDs
* Input: Value to display

* Output: None.

*******************************************************************/

void DisplayValueOnLEDs (unsigned int wvalue) {

_LEDS = value;

_LATA9 = LEDO;
_LATA10 = LEDI1;
_LATAll = LED2;
_LATC8 = LED3;
_LATC9 = LED4;
_LATB12 = LED5;
_LATB2 = LED6;
_LATB3 = LED7;

}

/**

End of File

*/
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5.4 eedata.h/VHg
HERHE < >, oMk,

* PICF32KA304 Data EEPROM header

(c) Copyright 1999-2015 Microchip Technology, All rights reserved

* % o

<See generated header files for additional copyright information.>

*/

/********************************************************************

* Function: EEData WTL

* Precondition: None.

* Overview: Write one word of EEData

* Input: Action to take: Erase or Write, Data to write
* Output: None.

*

******************************************************************/

void EEData WTL(unsigned int action, unsigned int data);

/********************************************************************

* Function: EEData Erase

* Precondition: None.

* Overview: Set up erase of one word of EEData
* Input: None.

* Output: None.

*

******************************************************************/

void EEData Erase(void);

/********************************************************************
* Function: EEData Write

* Precondition: None.

* Overview: Set up write of one word of EEData

* Input: Data to write

* Output: None.

*

******************************************************************/

void EEData Write (unsigned int data);

/********************************************************************
* Function: EEData Read

* Precondition: None.

* Overview: Read one word of EEData

* Input: None.

* Qutput: Value read from EEData

*

******************************************************************/

unsigned int EEData Read(void);

/**
End of File
*/
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5.5 eedata.c/Vlg
HWArEBRH < >Hik, Bk,

/‘k*
Data EEPROM Write and Read

<See eedata.c for file description information.>

*/

/*
Copyright (c) 2013 - 2015 released Microchip Technology Inc. All
rights reserved.

<See generated header files for additional copyright information.>

*/

#include <xc.h>
#include "eedata.h"

#define ERASE_ EEWORD 0x4058
#define WRITE EEWORD 0x4004

int  attribute  ((space(eedata))) eeData = 0x0;
unsigned int offset = 0x0;

/**********************************k*k**k****k***************************

* Function: EEData WTL

* Precondition: None.

* Overview: Write one word of EEData

* Input: Action to take: Erase or Write, Data to write
* Qutput: None.

**k**********k*k**k*****************k*k**k****k‘k***************************/

void EEData WTL(unsigned int action, unsigned int data) {

// Set up NVMCON to write one word of data EEPROM
NVMCON = action;

// Set up a pointer to the EEPROM location to be written
TBLPAG = builtin tblpage (&eeData);

offset = builtin tbloffset (&eeData);

~_builtin tblwtl (offset, data);

// Issue Unlock Sequence & Start Write Cycle
__builtin write NVM();

// Wait for completion
while (NVMCONbits.WR) ;

/********************************************************************

* Function: EEData Erase

* Precondition: None.

* Overview: Set up erase of one word of EEData
* Input: None.

* Output: None.

*

******************************************************************/

void EEData Erase(void) {

EEData WTL(ERASE EEWORD, 0);
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/********************************************************************
* Function: EEData Write

* Precondition: None.

* Overview: Set up write of one word of EEData

* Input: Data to write

* Output: None.

*

******************************************************************/

void EEData Write (unsigned int data) {

EEData WTL (WRITE EEWORD, data);

/********************************************************************
* Function: EEData Read

* Precondition: None.

* Overview: Read one word of EEData

* Input: None.

* Output: Value read from EEData
*

******************************************************************/

unsigned int EEData Read(void) ({

// Set up a pointer to the EEPROM location to be read
TBLPAG = builtin tblpage (&eeData);
offset = builtin tbloffset (&eeData);

// Read the EEPROM data
return  builtin tblrdl (offset);

/**
End of File
*/
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5.6

main. cBEUE IR

main. BB g, WTFPR. BERM < >4k, ook, cEm
A LAt R

/**

Generated Main Source File

<See generated main.c for file information.>

*/

/*

(c) 2016

Microchip Technology Inc.

and its subsidiaries.
this software and any derivatives exclusively with Microchip

You may use
products.

<See generated main.c for additional copyright information.>

*/

#include
#include
#include
#include

"mcc_generated files/mcc.h"
"eedata.h"

"LEDs.h"

"libpic30.h"

#define IC DELAY 1000000

unsigned int data write
unsigned int data read

0x0;
0x0;

/*
Main application
*/
int main (void) {
// initialize the device
SYSTEM_Initialize();
(1) |

while
data write++;

// Erase one word of data EEPROM
EEData Erase();

// Write one word of data EEPROM
EEData Write(data write);

// Read one word of data EEPROM
data read EEData Read();

-

// Display result on LEDs
DisplayValueOnLEDs (data read);

// Delay change on LEDs so visible

__delay32(IC DELAY); // delay in instruction cycles

return -1;
}
/**
End of File
*/

© 2018 Microchip Technology Inc.
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5.7 #F&kJF5 ANEEData

BAE EEData 5 N A, UG LT 75

1. #E— %4 EEPROM =+,

2. ¥ 5 AN EEPROM 8 174§

3. K 4L 2| EEPROM.

HT#Fx EEData - 5 N — MRS T eedata. e (BE5.571) ©

Xt T PIC24F32KA304 &3 1, fE#EFR 85 NEEData < Hil, & ZH —MEHFIIEA
NVMKEY (fENVMCONH)

it 1 P9 B R HOR R AL i«

* unsigned int  builtin tblpage (const void *p);

e unsigned int  builtin tbloffset (const void *p);
e void builtin tblwtl (unsigned int offset, unsigned int data);
e void builtin write NVM(void);

1 060X bR R V4045 B, i 5 L (MPLAB® XC16 C4i % 88 F /0 45 #)
(DS50002071E_CN) KMt G “ N B R .

5.8 i{LEXEEData

Xt T AR, 5 NEEData5, #i%HEEData 5.

HIT 1 EEData i) — MBS AL T eedata. e (5.5 .
FRRAE B R Ok A b -

e unsigned int  builtin tblpage (const void *p);

e unsigned int  builtin tbloffset (const void *p);
* unsigned int  builtin tblrdl (unsigned int offset);

AKX e K SR, W 23 WL (MPLAB® XC16 C4 i % A /48 B)
(DS50002071E_CN) [5G “HNE R .

59 71ELED L B/REHE LK ER

TEJERAR LED BB R gidax FiZss i 5 EoNE A, BN =4 i 05 LED 2,
M, TR R A RN 2 M H i SR A, u@ﬂumﬁﬁ%‘%ﬁ\i&ﬁﬁ (LAT LEDSbits.w) ,
25 A LL YT I & AN A, DA K LR E 48 OF #0051 AT B os (il i,
LATAbits.LATA9 = LAT_LEDSbitS.LAT_LEDO) o

FF 8@ B & Mg M AR AL F LEDs . h i (B55.291) &

F ¥ LED {1 5 o O 51 BIAARES A7 F LEDs . ¢ (555.371) &

T AT 0 5 7 R 22 B 0 T 2 S B LED 1 PR Rk B2 8 H N IR (iR i Be Jy, PRt
THRAMEH delay () BREL (A2 REEMPITESE.
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A. 7£ MPLAB X IDE HiZ4T/4H5

B\, flg—uH:

1. JB31MPLAB X IDE.

2. MIDEHEBEH &I H 'S (File>New Project (SCHE>H#H) ) .«
3. MR R NI -

a) Choose Project GEFEIIB) : % # “Microchip Embedded” (Microchip
A , AR5 “Standalone Project” (JESZIHH) &

b) Select Device GEFERM) « EHRGIZHAF.

c) Select Header GE#FARAL) : L.

d) Select Tool GEHETH) : #id/755 (Serial Number, SN) SNxxxxxxi&
BRI T R SRR T AT AR ERSN, EH AR T IEH
wH, HRVEMGE R, ES IR TR0,

e) Select Plugin Board GEFEERER) : L.

f) Select Compiler (E#E4RiFa) : EFEXCI16 (FHKAE) [binXiFIAL
H]. WRXC16 FRE/RImFER, IR OB 2¢3% H MPLAB X IDE
R AT AT SCAF . 1 $% Tools>Options (T H:>i&5) , #.i;Build Tools
(i T H) %W+ i Embedded (0223 T H) #401, EHRENwF
2B, ARIEMER, H2 WMPLAB XC16 f1MPLAB X IDE (A%,

g) Select Project Name and Folder GE#IH ZMCMH4FR) « NIHMH.

WAE, B — AU RAFRBIRID (BRIEEAMEH T MCC) -
1. ffHid Projects (IUH) % H AT H 4 Fk. &+ New>Empty File i >4

HC) o BERTE R 5 New Empty File CGHrias (ACE) KHEHE .

2. {f “File name” (4D FHINAHK.

#i.ik Finish G20

A P $6 5 R BT R AR IR G 2 2 (I g dE g i b, AR5 i % File>Save
>R

S RACHS IE N AR B 24 E . AR %% Debug Run CRRIE1T) PATAIS . R B
LED ¥ # . HidiHalt (B15) 5T,

& 20: TAEER

»w

B =
|Del::lug Main F'ru:uject| |Fir1ish Debugger Session (Shift+ F5]|
WIREIT Hi=
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B. ZREUH{FANBEF

KA SCR R i MPLAB XC16 3 H, 2545 PIC24F PIM ] Explorer 16/32 ¢ H1 9V #h i Ha,
VAL, JRE SR (ICSP™) JE{5. #H MPLAB X IDE #17H % .

B.1 #KE(MPLAB X IDE fil MPLAB XC16 C %; %53
A ALL R R 4E$R 5] MPLAB X IDE v3.45 J BL I i A

http://www.microchip.com/mplab/mplab-x-ide

A LA P k4R 2] MPLAB XC16 C 4 i85 v1.26 & LA L JiA
http://www.microchip.com/mplab/compilers

B.2 IREYMPLABAISECE R (MCC)
AL R P HER EIMCC v3.25 K UL R A :
http://www.microchip.com/mplab/mplab-code-configurator
B.3 #KEXPIC® MCU#:H#&LR (PIM)

Microchip Technology Wi F /LA~ A B gt 1 7451 48 F (1) PIC MCU PIM:
PIC24FJ128GA010: http://www.microchip.com/MA240011
PIC24F32KA304: http://www.microchip.com/MA240022

B.4 3KEXIi E Explorer 16/324%

Explorer 16/32 FF AR« Ji BRI AT SCRS o] A LA P 14K 31«
http://www.microchip.com/dm240001-2

TRINE T BRI G E
£11:  THKBRER X%
Wk 1774 prii= 3 ek /1 % prih=

JP2 ST J37 Wi FF
J19 i FF J38 i IF
J22 Wi T J39 R
J23 Bk Ja1 i FF
J25 T J42 i FF
J26 Gy J43 Bk
J27 i FF Ja4 R\
J28 i FF J45 R
J29 5 FF J50 4
J33 i FF

B.5 3RE{MicrochipifiX T E
AILEAN T FF T B T AR 4R 2147 4 AR X As

http://www.microchip.com/development-tools
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